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Technical Support
If you have difficulties using DeskFX Audio Effect Processor please read the applicable topic 
before requesting support. If your problem is not covered in this user guide please view the 
up-to-date DeskFX Audio Effect Processor Online Technical Support at 

www.nchsoftware.com/deskfx/support.html. 
If that does not solve your problem, you can contact us using the technical support contacts 
listed on that page.

Software Suggestions
If you have any suggestions for improvements to DeskFX Audio Effect Processor, or 
suggestions for other related software that you might need, please post it on our Suggestions 
page at www.nch.com.au/suggestions/index.html. 

Many of our software projects have been undertaken after suggestions from users like you. 
You get a free upgrade if we follow your suggestion.

www.nchsoftware.com/deskfx/support.html
www.nch.com.au/suggestions/index.html
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NCH Software Suite
This is a useful way to browse all the software available from NCH Software
You can see a set of products by type like Audio, Video and so on and view the product. From 
there you can try out the product and it will download and install it for you to trial. If you already 
have the product installed then you can click "Run It Now" and the program will be launched for 
you.
There is also a list of features for products in the category. Click on a feature, such as "Edit a 
Video File", to install a product with that ability.
Search  
Search our website for products matching any keywords you type. 
See more of our software  
Browse our website for more software. 
Subscribe to our newsletter 
You can subscribe to our newsletter for announcements of new releases and discounts. You 
can unsubscribe at any time. 
See the latest discounts for purchase  
See the latest discounts we are offering for purchasing our products. 
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Options
Options dialog lets you choose the devices to use DeskFX with. Any chosen device will modify 
the audio output. If the current default device doesn't apply the effects, check in Options dialog 
if that device is marked for audio modification. If at any point, you don't want a device to modify 
audio with the effects, untick that device from Options dialog. 
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Keyboard Shortcuts
The following list shows shortcuts used in DeskFX.
Main Window
● Open Help F1
● Show Full Menu Alt
● Options Ctrl+O
● Exit Alt+F4
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Software License Terms
Our goal is for every user to have a successful experience with our software. We offer it to you 
on the basis that you accept our End User License Agreement (EULA).
This EULA limits our liability and is governed by an arbitration agreement and venue 
agreement. Please read below as these terms affect your rights.
1. The copyrights in this software and any visual or audio work distributed with the software 
belong to NCH Software and others listed in the about box. All rights are reserved. Installation 
of this software and any software bundled with or installed-on-demand from this software, 
including shortcuts and start menu folders, is licensed only in accordance with these terms. 
These copyrights do not apply to any creative work made by you, the user.
2. By installing, using or distributing the software you, on your own behalf and on behalf of your 
employer or principal, agree to these terms. If you do not agree to any of these terms, you may 
not use, copy, transmit, distribute, nor install this software - return it to the place of purchase 
within 14 days to receive a full refund.
3. This software, and all accompanying files, data and materials, are distributed "as is" and with 
no warranties of any kind, whether express or implied except as required by law. If you intend 
to rely on this software for critical purposes you must test it fully prior to using it, install 
redundant systems and assume any risk.
4. We will not be liable for any loss arising out of the use of this software including, but not 
limited to, any special, incidental or consequential loss. Your entire remedy against us for all 
claims is limited to receiving a full refund for the amount you paid for the software.
5. You may not use this software in any circumstances where there is any risk that failure of 
this software might result in a physical injury or loss of life. You may not use this software if you 
do not regularly backup your computer, or do not have antivirus and firewall software installed 
on the computer, or keep sensitive data unencrypted on your computer. You agree to 
indemnify us from any claims relating to such use.
6. You may copy or distribute the installation file of this software in its complete unaltered form 
but you may not, under any circumstances, distribute any software registration code for any of 
our programs without written permission. In the event that you do distribute a software 
registration code, you will be liable to pay the full purchase price for each location where the 
unauthorized use occurs.
7. Use of data collected by the software is subject to the NCH Software Privacy Statement 
which allows automatic anonymized collection of usage statistics in limited circumstances.
8. Choice of Law. If you reside in the United States, your relationship is with NCH Software, 
Inc, a United States company, and this agreement is governed by the laws and courts of 
Colorado. If you reside anywhere in the world outside of the United States, your relationship is 
with NCH Software Pty Ltd, an Australian company, and this agreement is governed by the 
laws and courts of the Australian Capital Territory. Such courts have continuing and exclusive 
jurisdiction over any dispute between you and us, regardless of the nature of the dispute.
9. U.S. Customers Only: Arbitration Agreement and Class Action Waiver: PLEASE READ THIS 
CAREFULLY. IT MAY AFFECT YOUR RIGHTS.
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If you reside in the United States, NCH Software and you agree to arbitrate all disputes and 
claims between us. This agreement to arbitrate is intended to be broadly interpreted. 
References to "NCH" "you," and "us" include our respective subsidiaries, affiliates, agents, 
employees, predecessors in interest, successors, and assigns. This arbitration agreement 
does not preclude you from bringing issues to the attention of U.S. federal, state, or local 
agencies. Such agencies can, if the law allows, seek relief against us on your behalf. This 
Agreement evidences a transaction in interstate commerce, and thus the Federal Arbitration 
Act governs the interpretation and enforcement of this provision. This arbitration provision shall 
survive termination of this Agreement.
A party who intends to seek arbitration must first send to the other, by certified mail, a written 
Notice of Dispute ("Notice"). The Notice to NCH should be addressed to:
Legal Department
NCH Software, Inc.
6120 Greenwood Plaza Blvd, Ste 120
Greenwood Village CO, 80111
USA 
("Notice Address"). The Notice must (a) describe the nature and basis of the claim or dispute; 
and (b) set forth the specific relief sought ("Demand"). If NCH and you do not reach an 
agreement to resolve the claim within 30 days after the Notice is received, you or NCH may 
commence an arbitration proceeding. The amount of any settlement offer made by NCH or you 
shall not be disclosed to the arbitrator.
A. The arbitration will be governed by the Commercial Arbitration Rules and the Supplementary 
Procedures for Consumer Related Disputes (collectively, "AAA Rules") of the American 
Arbitration Association ("AAA"), as modified by this Agreement, and will be administered by the 
AAA. The AAA Rules are available online at adr.org, by calling the AAA at 1-800-778-7879, or 
by writing to the Notice Address. The arbitrator is bound by the terms of this Agreement. All 
issues are for the arbitrator to decide, including issues relating to the scope and enforceability 
of the arbitration provision. Unless NCH and you agree otherwise, any arbitration hearings will 
take place in Greenwood Village Colorado. If your claim is for $10,000 or less, we agree that 
you may choose whether the arbitration will be conducted solely on the basis of documents 
submitted to the arbitrator, through a telephonic hearing, or by an in-person hearing as 
established by the AAA Rules. If your claim exceeds $10,000, the right to a hearing will be 
determined by the AAA Rules. Regardless of the manner in which the arbitration is conducted, 
the arbitrator shall issue a reasoned written decision. NCH will pay all AAA filing, 
administration, and arbitrator fees for any arbitration initiated in accordance with the notice 
requirements above. If, however, the arbitrator finds that either the substance of your claim or 
the relief sought in the Demand is frivolous or brought for an improper purpose then the 
payment of all such fees will be governed by the AAA Rules. In such case, you agree to 
reimburse NCH for all monies previously disbursed by it that are otherwise your obligation to 
pay under the AAA Rules. In addition, if you initiate an arbitration in which you seek more than 
$75,000 in damages, the payment of these fees will be governed by the AAA rules.
B. The arbitrator may award declaratory or injunctive relief only in favor of the individual party 
seeking relief and only to the extent necessary to provide relief warranted by that party's 
individual claim. YOU AND NCH AGREE THAT EACH MAY BRING CLAIMS AGAINST THE 
OTHER ONLY IN YOUR OR ITS INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR 
CLASS MEMBER IN ANY PURPORTED CLASS OR REPRESENTATIVE PROCEEDING. 
Further, unless both you and NCH agree otherwise, the arbitrator may not consolidate more 
than one person's claims, and may not otherwise preside over any form of a representative or 
class proceeding. If this specific provision is found to be unenforceable, then the entirety of this 
arbitration provision shall be null and void.
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C. Notwithstanding any provision in this Agreement to the contrary, we agree that if NCH 
makes any future change to this arbitration provision (other than a change to the Notice 
Address) you may reject any such change by sending us written notice within 30 days of the 
change to the Arbitration Notice Address provided above. By rejecting any future change, you 
are agreeing that you will arbitrate any dispute between us in accordance with the language of 
this provision.
D. To opt out of this Arbitration Agreement and class action waiver send an Opt Out notice to 
the Notice Address stating "I am electing to opt out of the Arbitration Agreement and class 
action waiver contained in the Legal Terms applicable to my purchase of an NCH product." 
Your Opt Out Notice must include the date and proof of purchase. The Opt Out Notice must be 
postmarked no later than thirty (30) days after the date of purchase. A separate Opt Out Notice 
must be sent for each product purchased.
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Overview
DeskFX audio enhancer software is designed for you to modify and enhance the music and 
audio played through your speakers and headphones, to provide you with the best possible 
sound experience.
Features
● Audio effects include equalize, amplify, reverb, chorus, wahwah, vibrato, tremolo and more
● Boost the bass on your music
● Switch between visual, graphic or parametric equalizer modes
● Create a sophisticated, customized, audio experience
● Adjust your sound to suit your listening environment
● Optimize and improve the music played through the speakers
● Power and flexibility to manipulate the audio on speakers
● Suppress unwanted noise with live low and high pass filters
● Apply an unlimited number of audio effects
● Layer effects to create your own unique sound
● Equalize the audio in your room for the perfect sound
● System-wide equalizer with up to 20 bands
● Intuitive interface makes it easy to customize effects
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Presets Tool - Presets
Presets
Presets tool can be found in the Home tab. This tool lets you choose one of the available 
presets that comes with DeskFX. Several presets available for the choice of users:
   -Restaurant:
   -Restaurant presets compresses the audio to create EQ that is suitable for use in restaurants
   -Gym:
   -Increased bass for gym like environments.
   -Foyer:
   -Changes the audio to sound like it is playing in foyer.
   -Retail:
   -Retail environment preset
   -Waiting Room:
   -Waiting room preset.
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Effects - Amplify
Amplify
To 'amplify' is to increase the loudness or volume of the selected region. To make a part of the 
recording softer or louder, select it and then use the menu Effects -> Amplify. The volume is 
entered in percent (100 being no change, 50 being -6dB softer or 200 being +6dB louder).
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Effects - Equalizer
Equalizer
An equalizer changes the frequency response of a signal so it has different tonal qualities. 
Use the radio buttons at the left to select between Visual, Graphic, and Parametric Equalizer 
views.
Visual Equalizer  
Left click on any point to create a new band point. To remove a band point, right click on it. To 
assist you with shaping the Equalizer graph in the way you want, there is a preset list that 
displays the most common sorts of filters used in the Equalizer graph. You can choose any 
preset filter from the list and then manipulate the filter to achieve the effect you desire. The list 
of filters to choose from and how you can shape them are explained below. Note that all fields 
where a frequency value is entered can have a maximum value of 20000 (Hertz). 
Graphic Equalizer 
The Graphic Equalizer uses discrete sliders to set the gain or attenuation of a signal at a 
particular frequency. You can select how many sliders you would like to manipulate by entering 
a value between 3 and 20 in the box at the top of the display. When you change the number of 
sliders you would like to utilize, the frequencies are automatically allocated to best span the 
audible frequency range from 20Hz to 20kHz. Selecting presets allows you to easily configure 
common filters such as low pass or high pass. Note that when you change the Graphic 
Equalizer, the Visual and Parametric Equalizer views are not changed, as the changes in the 
three views are not compatible. 
Parametric Equalizer 
The Parametric Equalizer is similar to the Graphic Equalizer, but with more control. You can 
adjust the frequency and bandwidth of the individual sliders by left clicking on the frequency or 
Q values below each slider. Frequency must be set between 20Hz and 20,000 Hz. The Q 
parameter must be set between 0.05 and 20. A higher Q causes the gain or attenuation peak 
at the frequency to be much sharper, and therefore less likely to impact adjacent frequency 
content, while a lower Q applies the modification more smoothly across the frequency 
spectrum. 
   -Band Pass Filter
   -Keeps only those frequencies in the audio between a certain range.    -Start Frequency
   -The lower cutoff frequency value, in Hertz.
   -End Frequency
   -The upper cutoff frequency value, in Hertz.
   -Slope Length
   -The width of the slope extending from the lower and upper cutoff points, in Hertz.
   -Amplitude
   -The degree that the frequencies outside the cutoff range are suppressed. 6dB means the 
volume is reduced to one-half, 12dB means the volume is reduced to one-quarter. Maximum 
value is 60dB.
   -Band Stop/Cut Filter
   -Keeps all frequencies in the audio except those between a certain range. 
   -Start Frequency
   -The lower stop frequency, in Hertz.
   -End Frequency
   -The upper stop frequency, in Hertz.
   -Slope Length
   -The width of the slope extending from the lower and upper stop points, in Hertz.
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   -Rejection
   -The degree that the frequencies inside the stop range are suppressed. 6dB means the 
volume is reduced to one-half, 12dB means the volume is reduced to one-quarter. Maximum 
value is 60dB.
   -High Pass Filter
   -Keeps only those frequencies in the audio above a certain value. 
   -Pass Frequency
   -The point at which all frequencies above are to be kept, in Hertz.
   -Slope Length
   -The width of the slope extending from the pass frequency, in Hertz.
   -Low Pass Filter
   -Keeps only those frequencies in the audio below a certain value. 
   -Pass Frequency
   -The point at which all frequencies below are to be kept, in Hertz.
   -Slope Length
   -The width of the slope extending from the pass frequency, in Hertz.
   -Notch Filter
   -Attenuates the frequencies in the specified range to very low levels and passes all other 
frequencies unaltered. There is no slope - frequencies are either attenuated or not. 
   -Start Frequency
   -The lower cutoff frequency value, in Hertz.
   -End Frequency
   -The upper cutoff frequency value, in Hertz.
   -Boost Filter
   -Either attenuates or boosts frequencies in the specified range and passes all others 
unaltered. 
   -Start Frequency
   -The lower boost/cut frequency value, in Hertz.
   -End Frequency
   -The upper boost/cut frequency value, in Hertz.
   -Slope Length
   -The width of the slope extending from the lower and upper boost/cut points, in Hertz.
   -Amplitude
   -The degree that the frequencies inside the boost/cut range are either boosted or cut. 6dB 
means the volume is boosted to twice the original amount, and 12dB means the volume is is 
boosted to four times the original amount. 20dB.
   -High Pass Shelf Filter
   -Attenuates signals of frequencies below the cut frequency and passes all others unaltered. 
   -Start Frequency
   -The lower cut frequency value, in Hertz.
   -Slope Length
   -The width of the slope extending from the lower and upper cut points, in Hertz.
   -Rejection
   -The degree that the frequencies inside the cut range are cut. 6dB means the volume is 
attenuated to about half the original level, and 12dB means the volume is attenuated to about a 
quarter of the original level.
   -Low Pass Shelf Filter
   -Attenuates signals of frequencies above the cut frequency and passes all others unaltered. 
   -Start Frequency
   -The lower cut frequency value, in Hertz.
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   -Slope Length
   -The width of the slope extending from the lower and upper cut points, in Hertz.
   -Rejection
   -The degree that the frequencies inside the cut range are cut. 6dB means the volume is 
attenuated to about half the original level, and 12dB means the volume is attenuated to about a 
quarter of the original level.
   -Bass Boost Filter
   -Amplifies sub-bass and bass frequencies, and reduces low mids onwards by -12 dB. 
   -Default
   -Adds +6 dB to sub-bass and bass frequencies.
   -High
   -Adds +12 dB to sub-bass and bass frequencies.
   -Very High
   -Adds +20 dB to sub-bass and bass frequencies.
If you are using the equalizer simply to drop lower frequencies, you should always try the High 
Pass filter first (Effects menu -> High Pass Filter), because it is better and faster for very low 
frequencies.
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Effects - Echo
Echo
An echo is a repeat of the sound after a short time (usually 400 - 1000ms). It sounds a bit like 
the person is in a large stadium or is shouting between two mountains.
To add echo select the region and use the menu Effects -> Echo then specify the duration and 
amplitude of the echo. The duration is the length of time after which the sound repeats - 
usually this is between 400 and 1000ms. The amplitude can be between 1 - 99% (99 being a 
very loud echo).
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Effects - Reverb
Reverb
Reverb is many small randomized reflections of a sound that come after a set time. It is most 
noticeable in when someone is speaking in a room, hall, etc. When you record in a studio, 
there is usually very little reverb which can make the recording sound flat. Adding reverb to 
your tracks can help to make the recording feel more 'live.' The reverb level is the amplitude - 
99 is very wet, 0 is dry. The time can be between 100 and 800ms - 200ms sounds like a small 
room or 800ms sound like a large hall.
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Effects - Flanger
Flanger
A Flanger sound effect is similar to the phaser except that the delay is slowly modulated over 
time. You specify the starting delay time (default 5ms), the frequency of modulation in times 
per second (default 0.5Hz which is 2 seconds) the depth of modulation (default 70%) and the 
wet dry gain (100% for wet, 0% for dry, default 60%).
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Effects - Vibrato
Vibrato
The vibrato sound effect is a pulsating of the pitch at a depth and frequency specified by the 
user. The higher the Frequency (Hz) set, the more often the pulses will be heard, and the 
higher the Depth (semitones), the wider the fluctuation in pitch will be.
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Effects - Tremolo
Tremolo
The tremolo sound effect is similar to the vibrato effect, except that the amplitude pulsates 
rather than the pitch. The higher the Frequency (Hz) set, the more often the pulsation will be 
heard, and the higher the Depth (%), the deeper the fluctuation in volume.
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Effects - Wah-Wah
Wah-Wah
As the name suggests, the effect modulates a specified frequency band within the sample, 
which results in the characteristic "Wah wah" sound. The effect is a bandpass filter with its 
center frequency (not to be confused with the center frequency parameter, below) alternating 
between a min frequency and max frequency (specified by the center frequency and depth 
parameters) and from max frequency to min frequency. The frequency of alternating direction 
is represented as a triangular wave with a frequency specified by the wah frequency parameter.

Resonance: also known as Q or emphasis, this parameter controls the resonant peak of the 
bandpass filter. This value determines the sharpness of the wah-wah effect. Higher values 
produce more resonant/peaky tones.
Depth: this parameter determines the frequency range swept by the bandpass filter. Its range 
is specified as a percentage of the range (0 to center frequency). If the value of the percentage 
of the range (0, center frequency) is specified as X, the min and max frequencies are (center 
frequency - X) and (center frequency + X).
Center Frequency: This parameter is the center frequency of the bandpass filter sweep, and is 
used to determine the min and max frequencies as mentioned above.
Wah Frequency: This is the frequency of alternating the direction of the sweep, or the 
frequency of the wah-wah sound. It is the frequency of the triangular wave described above.
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Effects - Chorus
Chorus
The chorus sound effect is used to make one voice or one instrument sound like 3 voices or 
instruments by playing the original with variably delayed and slightly pitch changed copies of 
the original.
Note: Chorus is a very useful way to make a mono source sound more stereo. You should 
convert your file to stereo first before using Chorus.
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Effects - Distortion
Distortion
While normally we do everything to reduce distortion, sometimes you want to add it. It is 
popular for use with guitars. The distortion is measured between 0.0 (off) and 1.0 (clipping). 
You also specify the level where it kicks in in dB.
For a more consistent sound, you should apply Dynamic Range Compression first before you 
add distortion.
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Effects - High-Pass
High-Pass Filter
A high-pass filter (sometimes called a low cut filter) removes all low frequencies below a 
specified Hz. This is useful if you want to make your recording sound 'clearer' or less 'muddy'. 
It is very usual to use a high-pass filter of about 300Hz on all voice recordings to improve 
intelligibility.
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Effects - Low-Pass
Low-Pass Filter
A low-pass filter removes all high frequencies above a specified Hz. This is useful if you want 
to make your recording sound 'clearer'. It is very usual to use a low-pass filter of about 1600Hz 
on all voice recordings to improve intelligibility.
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Effects - Compressor
Compressor
The compressor sound effect limits the volume levels of a sound recording so that it stays 
within a certain loudness range. An example of where it is used is in TV broadcasting, where it 
ensures that the volume levels of ads are perceived as being louder than the television 
program itself, without any change in the actual broadcast volume.
It also has a use for recording audio from one medium to another, where the two mediums are 
not capable of handling the same range of volume levels (e.g. A CD can handle a much 
greater range than a cassette tape).

Compressor Settings
   -

   -Threshold:
   -Reduces the volume of sound below its Threshold. This can be useful for reducing or 
removing softer background noise from a recording.
   -Ratio:
   -Defines the ratio of the reduction in volume of sounds which exceed the compressor 
threshold. For example, if the ratio is 4:1 and the volume exceeds the threshold by 4dB, then 
the volume will be reduced to only exceed the threshold by 1dB. Note that a ratio of 1:1 means 
that there will be no change in volume; it effectively turns the compressor off.
   -Attack:
   -The time (between 0 and 1000 milliseconds) that it will take to apply the gain adjustment. 
The total gain adjustment required will be gradually introduced over this period.
   -Limit:
   -Defines the maximum decibel level that the sound recording will be allowed to rise up to. So 
if, for example, the Limiter Threshold was set to -2dB, then you would never hear the volume 
level of the recording get louder than -2dB. Any signal over the limiter threshold would be 
clipped, which would probably cause distortion. Note that setting the Limiter Threshold to 0dB 
effectively turns the limiter off, because 0dB represents the loudest signal possible in a digital 
recording.
   -Release:
   -The time (between 0 and 5000 milliseconds) that it will take to remove the gain adjustment 
once gain adjustment is no longer needed. This is the opposite of attack.
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Effects - Bass Boost
Bass Boost
The Bass Boost effect amplifies the sub-bass and bass frequencies, while reducing the low 
mids and onwards to further emphasize the bass.
Use the volume slider to amplify the sub-bass and bass frequencies (up to 80Hz) by +1dB to 
+20dB.
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Masking Effects - Audio Masking
Audio Masking
Audio masking is a technique used to create additional privacy in public spaces. Enabling 
audio masking will add a mask to the audio playing through your speakers that includes pink 
noise and conversation snippets. This provides additional anonymity to your patrons since it 
becomes more difficult to overhear other conversations taking place in the room.
Use the volume sliders to increase or decrease the volume of the two masks. Increasing the 
volume will increase the level of the mask file relative to the streaming audio.
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Masking Effects - Noise Generator
Noise Generator
Noise generator can generate different types of noises. Noise type drop down list can be used 
to select type of noise to add to playing audio. Currently it supports white and brown noise. 
Noise level slider can be used to adjust the volume of the noise generated. 
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Masking Effects - Background Loop
Background Loop
Background loop can be used to loop over a chosen file in the background to playing audio. It 
loops the chosen audio until the playing audio stops.
You can choose the background file to play by using the Browse button.
Background (dB) slider can be used to adjust the volume of the background audio file before 
mixing with the actual audio being played.
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